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Notes & URLs for this presentation can be found… 

» underneath the link to this slide show on 
granneman.com 

» at files.granneman.com/presentations/webdev/Your-
Digital-Toolbox-Software-Tips-Tricks-for-Web-
Developers-(-Other-Creatives).txt



Introductory



Modifier Keys



⌘ Command ⇥ Tab → Right

⌥ Option or Alt fn Function ← Left

⌃ Control ⌫ Delete ↑ Up

⇧ Shift ↩ Return ↓ Down

⎋ Escape

 Keyboard



⊞ Windows ⇥ Tab → Right

⎇/Alt Alt fn Function ← Left

⌃/Ctrl Control ⌫ Backspace ↑ Up

⇧ Shift ↵ Enter ↓ Down

⎋ Escape 𝌆 Menu

⊞ Keyboard



Bits & Bytes



1 bit b 1 binary digit (1 or 0)

1 byte B 8 bits

1 kilobyte KB 1024 bytes

1 megabyte M
B

1024 kilobytes

1 gigabyte GB 1024 megabytes

1 terabyte TB 1024 gigabytes

1 petabyte PB 1024 terabytes

1 exabyte EB 1024 petabytes

1 zettabyte ZB 1024 exabytes

1 yottabyte YB 1024 zettabytes



The problem: 1 MB (megabyte) was always 1,048,576 
(220) bytes 

But most people (non-nerds) thought that 1 MB is 
1,000,000 (106) bytes 

Same thing for all the other prefixes



The solution? 

Redefine kilobyte, megabyte, gigabyte & so on to mean 
what non-nerds think they mean 

Require nerds to learn & use new terms for the old 
numbers



Megabyte Mebibyte

= =

10002 bytes 10242 bytes

= =

106 bytes 220 bytes

= =

1,000,000 bytes 1,048,576 bytes



Decimal 
(Old Terms, New Values)

Binary 
(New Terms, Old Values)

kilobyte 
(kb)

103 1,000 kibibyte 
(kib)

210 1,024

megabyte 
(MB)

106 1,000,000 mebibyte 
(MiB)

220 1,048,576

gigabyte 
(GB)

109 1,000,000,000 gibibyte 
(GiB)

230 1,073,741,824

terabyte 
(TB)

1012 1,000,000,000,
000

tebibyte 
(TiB)

240 1,099,511,627, 
776

petabyte 
(PB)

1015 1,000,000,000,
000,000

pebibyte 
(PiB)

250 1,125,899,906,842,
620



Prefix Power Decimal Name

100 1 one

kilo 103 1,000 thousand

mega 106 1,000,000 million

giga 109 1,000,000,000 billion

tera 1012 1,000,000,000,000 trillion

peta 1015 1,000,000,000,000,000 quadrillion

exa 1018 1,000,000,000,000,000,000 quintillion

zetta 1021 1,000,000,000,000,000,000,000 sextillion

yotta 1024 1,000,000,000,000,000,000,000,000 septillion



Networking



Packets



When you transfer something on the Internet, your 
device breaks it up into formatted blocks of data called 
packets 

When you receive something, your device takes the 
packets & reassembles them into an email, webpage, or 
video



Why use packets? 

More efficient & reliable transmissions



Most packets are 1 KiB (1024 bits), divided into 3 parts

Header 96 bits Sender IP address 
Recipient IP address 
Protocol 
Packet number

Payload 896 bits Data

Trailer 32 bits Indicates packet end 
Error correction



Send a 2.6 KiB (2662 bit) mail? 
2600/896 = 3 packets 

View the Saint Louis Zoo home page? 
1.1 MiB = 9,227,469 bits 
9,227,469/896 = 10,299 packets 

Stream an 1.5 hr HD movie on Netflix? 
1.5 GiB = 12,884,901,888 bits 
12,884,901,888/896 = 14,380,471 packets



Protocols



“…a set of rules which is used by computers to 
communicate with each other across a network.” 
—Wikipedia



Sample protocols 

AppleTalk 
1985–2009 

NetBIOS Frames 
Windows, 1985–2001 

SMB (Server Message Block), now CIFS (Common 
Internet File System) 
Windows, macOS, & Linux, 1983–Now







Connection Types



Protocols, by connection type 

» Connection-oriented 
» Connectionless-oriented



Connection-oriented Connectionless-oriented

Assumes communication 
errors

Assumes no, or unimportant, 
errors

Designed for error-free 
transmissions

Faster because no error 
correction

If error detected, re-transmit Ignore errors: not every 
packet matter & error 
checking degrades signal

Protocol: TCP Protocol: UDP

Apps: Email, Web Apps: VoIP



TCP/IP



The two central Internet protocols: 

» TCP (Transmission Control Protocol): checks to make 
sure packets are delivered reliably 

» IP (Internet Protocol): tells packets where to go



Many other protocols ride on top of TCP/IP

HTTP Hypertext Transfer Protocol

FTP File Transfer Protocol

SMTP Simple Mail Transfer Protocol

POP3 Post Office Protocol

IMAP Internet Messaging Application Protocol

SSH Secure Shell

DNS Domain Naming Service



IP Addresses



IP address 

Unique number that identifies device on an IP network 

Like a street address, phone number, or email address



4 octets, each 0–255 

Examples: 

» 0.0.0.0 
» 216.23.180.5 
» 192.168.0.25 
» 255.255.255.255



Organizations that hand out IP addresses



2 ways a device can get an IP address 

1. Manually assign a static IP address to a device 
2. Automatically acquire an IP address from a DHCP 

server



Manually set IP address 
in Network Control 
Panel or System 
Preferences 

Problems 

» Tedious 
» Error-prone 
» Only OK for a very small 

number (<10) of devices



DHCP (Dynamic Host Configuration Protocol) 

Server assigns dynamic IP addresses from a pool (e.g., 
192.168.0.100–192.168.0.125) 
 
Ensures all IPs are unique 

Server assigns IP address for a lease: a limited period of 
time ranging from a few hours to a few weeks



DHCP Process 

1. Computer boots or connects 

2. Computer sends out request to DHCP server 

3. DHCP server assigns IP address from pool, as well as 
DNS, gateway, & subnet mask 

4. At end of lease, request repeats



IPv4 & IPv6



IPv4 is current standard 

0–255.0–255.0–255.0–255 gives 232 possibilities: 
4,294,967,296 

That seemed like a lot in 1981



We’re running out of IP addresses 

~18 million used for private networks 

Early on, certain organizations were assigned huge 
Class A blocks of 16,777,214 addresses … or more!



3.x.x.x



 9.x.x.x  
32.x.x.x



17.x.x.x



36.x.x.x



 6.x.x.x 28.x.x.x 215.x.x.x  

 7.x.x.x 29.x.x.x  

11.x.x.x  30.x.x.x  

21.x.x.x  33.x.x.x  

22.x.x.x  55.x.x.x  

26.x.x.x 214.x.x.x



 6.x.x.x 28.x.x.x 215.x.x.x  

 7.x.x.x 29.x.x.x  

11.x.x.x  30.x.x.x  

21.x.x.x  33.x.x.x  

22.x.x.x  55.x.x.x  

26.x.x.x 214.x.x.x

218,103,782!



 61.x.x.x
202.x.x.x

203.x.x.x

210.x.x.x

211.x.x.x



 61.x.x.x
202.x.x.x

203.x.x.x

210.x.x.x

211.x.x.x

83,886,070



As a result of IPv4 address exhaustion, we are going to 
have to move to IPv6



IPv6 uses 8 groups of 4 hexadecimal digits (0–F), 
separated by colons (:) 

Examples: 
» 2001:0db8:0000:0000:0000:0000:1428:57ab 
» 20a1:0db8:85a3:0042:1000:8a2e:0370:7334 
» FEDC:BA98:7654:3210:FEDC:BA98:7654:3210



0–F:0–F:0–F:0–F:0–F:0–F:0–F:0–F gives 2128 
possibilities: 3.403 × 1038 IPs 
 
340,282,366,920,938,463,463,374,607,431,768,211,456 

That’s 40,000 IPv6 addresses for every atom on the 
surface of the earth!



Special IP Addresses



Most IP addresses are public 

Devices with public addresses are directly connected 
to the Net 

There are other kinds of addresses, however: 
» Private addresses 
» localhost



Private IP addresses: ranges of IP addresses for 
internal networks only

IP Addresses # of IPs

192.168.x.x 65,536

172.16.x.x–172.31.255.255 1,048,576

10.x.x.x 16,777,216



Routers discard packets containing private IPs 

Device with private addresses can’t be directly 
connected to the Net like those with public addresses 
can 

Computers with private addresses can still use the Net, 
however 

How is this done?



NAT (Network Address 
Translation, AKA network 
masquerading) 

Router re-writes source 
and/or destination address 

Shields private network 
from public Internet



Localhost IP address (AKA loopback) 

IP address that every IP device in the world uses to 
refer to itself 

Always 127.0.0.1 

Computer equivalent of “me”





What is the Internet?



Now let’s branch out to the Internet, the network of 
networks that unites the world 

Uses TCP/IP & provides many different services: 
» Web 
» email 
» FTP 
» VoIP 
» messaging 
» file sharing



Internet ≠ Web! 

Web: interconnected documents linked by URLs 

Internet: interconnected networks linked by media 
(e.g., ethernet & Wi-Fi)













History



1969



January: Bolt, Beranek, & 
Newman hired by DARPA 
(Defense Advanced 
Research Projects Agency, 
part of the US Dept. of 
Defense) to create the 
ARPAnet, forerunner of 
the Internet

1969



July 21, 2:56 UTC: Neil 
Armstrong steps onto the 
moon



August: UNIX operating system created at AT&T’s Bell 
Telephone Labs for DEC PDP-7 by Ken Thompson & 
Dennis Ritchie

1969



December: 4 nodes on ARPAnet (UCLA, SRI, UCSB, & 
U. of Utah)

1969



Excellent, non-technical 
history of the visionaries 
who created the ARPAnet 

Katie Hafner & Matthew 
Lyon’s Where Wizards 
Stay Up Late



1971



September: 15 nodes on the ARPAnet

1971



Late in 1971: Email invented & sent by Ray Tomlinson

1971



1973



May: ARPAnet up to 36 nodes

1973



Email is 75% of ARPAnet’s traffic 

hubhost!middlehost!edgehost!user@uucpgateway.

somedomain.example.com

1973



1974



1974: TCP designed 

1982: ARPA & DoD mandate TCP/IP as protocols for 
ARPANET 

1984: DNS introduced 

1985: 1st registered domain name: symbolics.com



1990 
» ARPANET ceases to exist 
» 1st commercial dial-up ISP: The World 

1991: Tim Berners-Lee invents World Wide Web 

1992: 1,000,000 hosts on Net



1994 
» 1st e-commerce 
» 1st spam by Canter & Siegel 
» 1st cyberbank 
» 1st banner ads on Wired’s website 

1995 
» Streaming audio via RealAudio 
» WWW the #1 use of the Net 
» Netscape IPO starts dot-com craze 

1998 
» Google incorporated



2000: Napster sued 

2001: Viruses & worms sweep Net, targeting 
Microsoft’s software 

2002: Blogging takes off 

2003 
» SQL Slammer worm spreads worldwide in 10 minutes 
» RIAA sues file sharers
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Number of Internet Hosts



July 25, 2008: Google announces it has indexed 1 
trillion unique URLs



September 24, 2012 

142,038,482 active domains 

~74% are .com 

~84,234 registered every day



OSI Model



Lots of things have 7 layers



Taco Bell’s 7 Layer Burrito 

Refried beans 
Seasoned rice 
Lettuce 
Tomatoes 
Guacamole 
Cheese 
Sour cream



Big Mac 

Two all-beef patties 
Special sauce 
Lettuce 
Cheese 
Pickles 
Onions 
Sesame-seed bun



ISO OSI model (International Standards Organization 
Open Systems Interconnection) defines how computers 
communicate over a network



OSI Model divides the process into 7 connected layers 

Every layer supports the one above & offers services to 
the one below



Data Unit Layer Function Devices

Host 
(Software) 
Layers

Data

7 Application
Network services (HTTP, 
FTP, & IMAP)

Proxy Servers, 
Content Firewalls

6 Presentation
Data representation & 
encryption (SSL, WPA)

5 Session Interhost communication 
(Ports 22, 80, 443)

Segments 4 Transport
End-to-end connection & 
reliability (TCP & UDP)

Media 
(Hardware) 
Layers

Packets 3 Network
Data routing to correct 
destination (IP)

Routers, Firewalls

Frames 2 Data Link Physical addressing (MAC) NICs, Ethernet, 
802.11, Switches

Bits 1 Physical Media & signal 
transmission

Copper, Fiber, Wi-Fi, 
Hubs, Repeaters













Monitoring





Getting Hired



No one can do it all 

» Front end (HTML, CSS—& JavaScript) 
» Back end (PHP, .NET, Node.js—& JavaScript) 
» Designers 
» Server Admins 
» Network Admins 
» Database Admins



If you’re a programmer, use GitHub







If you’re a front-end developer, create websites



“I wish I could pay you, but I don’t have the budget. 
How about you let me use your work for free? I know 
it’ll be great exposure for you, and lead to paying 
work.”



“I wish I could pay you, but I don’t have the budget. 
How about you let me use your work for free? I know 
it’ll be great exposure for you, and lead to paying 
work.” 🖕



Domain 
Names



Domain Names 
Defined



Domain names (actually, that’s a slang term for most of 
what you see here) 

granneman.com

www.granneman.com

mail.granneman.com

ftp.granneman.com







.com

.org

.net

.edu

.mil

.gov

.int



ccTLD (Country Code TLD) 

Always 2 letters 

.us

.uk

.de

.fr

.jp

.su

.eu



“A domain hack is a domain name that suggests a word, 
phrase, or name when concatenating two or more 
adjacent levels of that domain.” —Wikipedia



.io (codepen.io) 

.gs (blo.gs) 

.to (cr.yp.to)



.fm (kdhx.fm & jazz.fm) 

.tv (abc.tv) 

I couldn’t find any examples for .am & .dj



.tv for Tuvalu 

10 sq. miles 

10,640 people 

$2.2 million/year from 
royalties on .tv—10% of  
government’s total revenue



New TLDs created out of greed & shortsightedness 

.auto ($2,488/yr) 

.bargains ($24.88/yr) 

.camera ($24.88/yr) 

.investments ($78.88/yr) 

.luxury ($588/yr) 

.museum ($100/yr) 

.sucks ($268.88/yr) 

.travel ($99/yr) 

.xxx ($99.99/yr)



Reserved TLDs 

.example

.invalid

.local

.localhost

.test







Rules for domain names 

A-Z, a-z, 0-9, - 

Cannot begin or end with - 

2–63 characters, not including the TLD





Common 3rd-level subdomains 

www

mail

blog

webmail

server

ns1

smtp

vpn

m

shop

ftp

test



Beware too many subdomains 

mar.ve.lo.us

this.is.too.many.subdomains.com





Real FQDNs 

www.thelongestdomainnameintheworldandthensomea

ndthensomemoreandmore.com

3.14159265358979323846264338327950288419716939

9375105820974944592.com

www.abcdefghijklmnopqrstuvwxyzabcdefghijklmnop

qrstuvwxyzabcdefghijk.com



Good & Bad Domain 
Names



Think before you register! 

Others might see things  
in your domain name 

you did not intend





therapistfinder.com



kidsexchange.net





cumstore.co.uk



dicksonweb.com



masterbaitonline.com



speedofart.com



wintersexpress.com



analisajoy.com



mp3shits.com



budget.co.ck



molestationnursery.com





Go for .com or .org first; if it’s a nerd site, try .io 

Avoid cruddy TLDs like .biz 

You do not need to register your domain name with 
every TLD (foobar.com, foobar.org, foobar.uk, 
foobar.io, &c) 

If you have multiple words, think about whether you 
want to run the words together (elderthings.com) or 
use hyphens (elder-things.com)



Registrars



March 2016 
Hostnames: 1,003,887,790 
Active Sites: 170,518,262



“A domain name registrar is an organization or 
commercial entity that manages the reservation of 
Internet domain names. A domain name registrar 
must be accredited by a generic top-level domain 
(gTLD) registry and/or a country code top-level 
domain (ccTLD) registry.” —Wikipedia



Domain Cost/year 
(min.).com $10.29

.net $12.48

.biz $11.88

.org $12.08

.info $10.15

.guru $24.88

.photography $16.88

.technology $16.88

.tattoo $22.88

.sexy $16.88

.xxx $84.89





Make a ranked list of desired domain names 

Try the first — if it’s available, buy it then 

If it’s not, see if it’s for sale 

If it’s not, try the second — if it’s available, buy it then 

Repeat 

Do not search, see that it’s available, & plan to buy later!



You have the legal right to transfer domains from one 
registrar to another 

Some make this easy, & some are almost criminally 
deceptive & difficult



You paid for 1 year at Registrar Foo 

You decide to transfer to Registrar Bar 

You pay a registration fee to Registrar Bar for a 
transfer, which includes another year 

When you transfer to Registar Bar, you also keep the 
year you paid for at Registrar Foo 

At Registrar Bar, you’re now registered for 2 years





Constant upselling of services when you just want to do 
one quick thing 

Hard to transfer domain names away from them to 
another registrar 

Sexist advertising 

Supported SOPA, a Congressional bill to censor the 
Internet (which fortunately was defeated) 

Former CEO proudly shot an elephant on safari





Constant upselling of services when you just want to do 
one quick thing 

Next to impossible to transfer domain names away 
from them to another registrar 

Incredibly difficult to find out how much they will 
charge before you get to the checkout screen AND 
create an account or login 

Expensive: $35/year, where most others are $10–15





People I respect highly love Gandi





Worst thing about Namecheap is its name 

Great prices, great service



DNS



How DNS Works



Domain Name System: “a distributed hierarchical 
naming system for … any resource connected to the 
Internet … [that works by] translating human-friendly 
computer hostnames into IP addresses.” —Wikipedia



The Internet uses 2 namespaces (ways to organize 
objects of various kinds): 

» IP addresses 
» Domain name hierarchy



DNS (Domain Name System) translates logical network 
numbers (IP addresses) into logical network names 
(DNS hierarchy) 

Humans are good with words, not numbers



Yes, more than 1 domain name can be bound to 1 IP 
address

mail.granneman.com 66.39.82.33

ftp.granneman.com 66.39.82.33

www.granneman.com 216.23.180.5

www.stlzoo.org 216.23.180.5

www.aclu-nj.org 216.23.180.5



DNS uses a tree data structure divided into zones 

After the root zone, the tree sub-divides into further 
hierarchical zones 

Each zone is the authoritative source for information 
about domains in its zone





Results cached 
by any DNS servers 
who passed along request





One Ring to rule them all, One Ring to find them, 

One Ring to bring them all and in the darkness bind them



IP Operator Location (Global/Local)

A 198.41.0.4 Verisign Anycast (5/0)

B 192.228.79.201 USC-ISI Anycast (2/0)

C 192.33.4.12 Cogent Communications Anycast (8/0)

D 199.7.91.13 University of Maryland Anycast (50/67)

E 192.203.230.10 NASA Anycast (125/141)

F 192.5.5.241 Internet System Consortium Anycast (57/0)

G 192.112.36.4 Defense Information Systems Agency Anycast (6/0)

H 128.63.2.53 US Army Research Lab Aberdeen, MA & San Diego

I 192.36.148.17 Netnod Anycast (58/0)

J 192.58.128.30 Verisign Anycast (61/13)

K 193.0.14.129 RIPE NCC Anycast (5/23)

L 199.7.83.42 ICANN Anycast (161/0)

M 202.12.27.33 WIDE Project Anycast (6/1)





DNS records store more than just IP addresses



A 
IP address 
gawain.websanity.com 23.239.25.194

CNAME 
Domain name alias 
www gawain.websanity.com



MX

SMTP Mail Exchange 
@ mail.messagingengine.com 10

@ mail.messagingengine.com 20

@ mail.messagingengine.com 30

TXT

Specialized records for a wide variety of purposes 
@ google-site-verification=PM8NGaec_0YkRwOie

@ v=spf1 include:spf.messagingengine.com -all

@ adn_verification=granneman

@ represents granneman.com



URL Redirect 
Offered by some DNS services 
@ https://www.granneman.com Unmasked

Remember, my domain name is granneman.com, 
represented by @ 

If someone goes to granneman.com, I want them to 
redirect to www.granneman.com



DNS Management



Your registar will usually provide tools to manage DNS 
for your domain name













Content



Planning



OmniOutliner 

Feature-rich, powerful outlining tool 

www.omnigroup.com/omnioutliner/ 

$0 (view only) / $10 / $60 
Educational: $6 / $36 
iOS: $0 (view only) / $30







Additions Pro provides over Essentials

» Display Notes in Pane 
» Custom Templates & Themes 
» Custom Styles 
» Batch Find 
» Password Encryption 
» Row Numbering 
» Attachments 
» Audio Recording 
» Rich Text 
» Column Visibility 
» Saved Filters 
» Text Folding 
» RegEx Search 
» Scripting Support 
» Customizable Keyboard Shortcut Sets 
» Export to RTFD & Excel







The Outliner of Giants 

Web-based, with lots of features & templates 

www.theoutlinerofgiants.com 

$0–2.49/month





Outline templates 

» 5 essay templates 
» Thesis and dissertation 
» Research paper 
» Project proposal 
» Class and lecture notes 
» Task & project management 
» Kanban schedule





Text Editors



Do not write in Word & then copy & paste into any 
online tool, as that very well may bring along crap into 
the resulting HTML 

Instead, write in a text editor, copy & paste into your 
online tool, & then format the content using the online 
tool



BBEdit 

After 30 days, you get an excellent simple text editor 

www.barebones.com/products/bbedit/ 

$0





If you get Sublime Text (coming up soon), you can just 
use it



Notepad++ 

Fast, powerful, & utilitarian text editor 

notepad-plus-plus.org 

$0 & open source





Storage (& Safety)



Dropbox 

Synchronize & share files 

www.dropbox.com 

$0 / $100 / $200 annually





Google Drive is nice, but it’s more data Google gets 
about you & Google’s online tools (e.g. Docs) don’t feel 
“right” when I’m using them 

YMMV



Collaboration



Google Docs 

Web-based, collaborative documents, spreadsheets, & 
slideshows 

docs.google.com 

$0





















Dropbox Paper 

Web-based, collaborative word processor 

paper.dropbox.com 

$0 while in beta









Apple iWork (Pages, Numbers, Keynote) 

App- & Web-based collaborative office suite 

www.icloud.com 

$0 to use iCloud (need Apple ID) 
$0 on new Macs & iOS devices; $20 otherwise













Pages on my Mac



Pages on my Mac





Numbers on my Mac

Multiple tables













Keynote on my Mac



Office 365 

App- & Web-based collaborative office suite 

office365.com 

9 different plans & prices, of course



Plans 

» Personal 
» Office 365 University 
» Home 
» Business Essentials 
» Business 
» Business Premium 
» ProPlus 
» Midsize Business 
» Enterprise











Draft 

Very sophisticated & feature-rich online text editor 

draftin.com 

$0





















Graphics & 
Multimedia



Software



Graphics



Photoshop 

Premier image editor 

www.photoshop.com 

$20/month





Acorn 

A much easier-to-use image editor than Photoshop 

www.flyingmeat.com/acorn/ 

$50





Paint.NET 

Best free image editor for Windows 

www.getpaint.net 

$0





Illustrator 

Premier vector drawing tool, especially for SVG 

www.adobe.com/products/illustrator.html 

$20/month





Screenshots



Built-In



macOS



Windows



Snagit 

Screenshot images or take videos & then edit them 

www.techsmith.com/snagit.html 

$50











Screencasts



ScreenFlow 

Powerful screencast recorder & editor 

www.telestream.net/screenflow/ 

$100





Camtasia 

Powerful screencast recorder & editor 

www.techsmith.com/camtasia.html 

$199 ($169 Educational)











Converters



Adapter 

Convert audio, video, & images 

www.macroplant.com/adapter/ 

$0













Handbrake 
 
Convert video (including DVDs) to MP4 or MKV 

handbrake.fr 

$0 & open source







VLC 

Convert video & audio — & it plays everything! 

www.videolan.org/vlc/ 

$0 & open source











Optimization



Design



Before responsive design, websites normally needed 
designs for 2 templates*: the home page & every other 
page

*Sometimes a site required more; the Saint Louis Zoo, for instance, needed a template for animal 
detail pages

























lg



md



xssm



Languages



Web-Native



Separation of Concerns 

Divide computer program into separate concerns, each 
focusing on a specific resource 

Structure: HTML 

Presentation: CSS 

Behavior: JavaScript



HTML: HyperText Markup Language 

Describes the semantic structure of a webpage 

developer.mozilla.org/en-US/docs/Web/HTML/
Element





CSS: Cascading Style Sheets 

Describes the presentation (formatting & positioning) 
of objects on a webpage 

developer.mozilla.org/en-US/docs/Web/CSS/
Reference





HTML & CSS Frameworks



Normalize.css 

A set of CSS resets so browsers render all elements 
more consistently 

necolas.github.io/normalize.css/ 

$0 & open source





HTML5 Boilerplate 

A set of HTML, CSS, JavaScript, & supporting files you 
can use to quickly build a site—& integrates with 
Bootstrap 

html5boilerplate.com 

$0 & open source







Foundation 

2nd most popular responsive framework on the Web 

foundation.zurb.com 

$0 & open source





Bootstrap 

Most widely used framework on the Web for developing 
responsive, mobile-first websites 

getbootstrap.com 

$0 & open source







JavaScript 

Lightweight, interpreted, object-oriented scripting 
language for Web pages 

developer.mozilla.org/en-US/docs/Web/JavaScript





JavaScript ≠ Java!



“Java is a general-purpose computer programming language 
that is concurrent, class-based, object-oriented, and 
specifically designed to have as few implementation 
dependencies as possible. It is intended to let application 
developers ‘write once, run anywhere’ (WORA), meaning that 
compiled Java code can run on all platforms that support Java 
without the need for recompilation. Java applications are 
typically compiled to bytecode that can run on any Java virtual 
machine (JVM) regardless of computer architecture.” —
Wikipedia 

“JavaScript is a high-level, dynamic, untyped, and interpreted 
programming language.” —Wikipedia



JavaScript Frameworks, 
Libraries, & Tools



JSON 



jQuery 

Most popular (65% of top 10 million websites!) 
JavaScript library, designed to simplify client-side 
scripting 

jquery.com 

$0 & open source





Node.js 

Open source runtime environment, built on Google’s V8 
JavaScript engine, for server-side JavaScript apps 

nodejs.org 

$0 & open source





React 

JavaScript library developed & maintained by Facebook 
for building user interfaces 

facebook.github.io/react/ 

$0 & open source





AngularJS 

JavaScript framework developed by Google for building 
single-page web applications 

angularjs.org 

$0 & open source





MEAN: a full-stack JavaScript-based open source 
stack 

» MongoDB: document-oriented NoSQL database 
» Express: Node.js web app framework 
» AngularJS: web app framework for single-page apps 
» Node.js: runtime for building server-side web apps



Server-Side



Instead of running in the client (the web browser), 
these run on the server



PHP 

Popular scripting language for the Web 

php.net 

$0 & open source





Ruby on Rails 

Web application framework written in Ruby that 
provides default structures for a database, a web 
service, & web pages 

rubyonrails.org 

$0 & open source





.NET 

Microsoft’s huge software framework for the Web, 
mobile, & desktop 

microsoft.com/net 

$0 & some parts are open source





CMS



What’s a CMS?



“A content management system (CMS) is a computer 
application that supports the creation and modification 
of digital content using a common user interface and 
thus usually supporting multiple users working in a 
collaborative environment.” —Wikipedia



Common features 

» Web-based publishing 
» Format management 
» WYSIWYG editor 
» Revision & version control 
» Asset indexing, search, & retrieval



2 components to a CMS 

» A front-end user interface that allows non-technical 
users to add, modify & remove content from a 
website without needing IT help 

» A back-end program that compiles content & 
templates & updates the website



CMS Yes! CMS No!

More than 1 editor 1 editor

Non-technical editors Technical editors

Large site Small site

Content changes regularly Billboard



Software



Try before you buy





Content Management Systems have to serve 4 
different user groups 

» Developers 
» Designers 
» Administrators 
» Editors



Developers 

Need a solid, agile, & well-documented application 
development platform 

Technical users



Designers 

Need easy theming & flexibility when it comes to 
information architecture 

Technical users



Administrators 

Need powerful & usable controls for managing users, 
rights, & assets 

Technical users



Editors 

Need usability that makes it easy to create, edit, & 
manage content 

Can be technical or non-technical users



All of the following… 

» use PHP & MySQL (other databases are often 
supported too) 

» are free & open source 
» can be used for multiple purposes & kinds of websites



Drupal 

Powerful but very complex “content management 
framework” used on 2% of websites worldwide 

www.drupal.org 

$0 & open source





Drupal core provides basic features & is extended via 
31,800* modules & 2000 themes**

* As of September 2015   ** As of February 2015



Problems with Drupal 

» Usability (although supposedly that’s better) 
» Difficult learning curve 
» No backward compatibility across major versions 
» Slower than single-task systems (e.g., blogging via 

WordPress) 
» 30,000+ modules, but many are incomplete or 

abandoned, do not work, only work for outdated 
versions, or are a bug farm



Joomla! 

2nd most widely used CMS 

www.joomla.org 

$0 & open source





Modules are of widely varying quality 

Many modules are commercial ($) 

Many security issues 

Seems pretty & usable at first glance, but complex & not 
as usable once you dig in



WordPress 

25% of the Web runs on WordPress! 

www.wordpress.org (& www.wordpress.com) 

$0 & open source



wordpress.org 
Download WordPress to manually install on your server 

wordpress.com 
Set up a free WordPress website in 5 minutes







$99/yr $299/yr



WordPress is an excellent, if a bit bloated, blogging tool 

WordPress is often used for other purposes that are not 
always appropriate (e.g., CMS for 100s of pages or 10s of 
1000s of files) 

Managing a lot of pages is cumbersome 

Lots of common features only come from 3rd party add-
ons (e.g., permissions, modular editing) 

Difficult to develop themes



Constantly updated & improved



Do not let your WordPress installs get out of date or 
they will be hacked!



Concrete5 

Open source, user-friendly CMS that is growing in 
popularity 

www.concrete5.org 

$0 & open source





Older but more communicative!



In-context editing makes it easy to add & edit content 

Various blocks allows editors to add & edit different 
kinds of content (e.g., text, images, videos, maps) 

Easy to change site structure, which automatically 
updates navigation



CMS Developers Designers Admins Editors

Drupal A- C+ A- C

Joomla! C D C D

WordPress A- C C B

Concrete5 B B+ B B+



Static Site Generators



1st websites were static HTML & CSS & were 
delivered to users exactly as stored 

» Quick to load 
» Every user saw the same thing 

Later, websites became dynamic & were generated by 
a web application 

» Slower to load 
» Every user sees something different



A static site generator gives the best of both worlds: 
templates & content are run through an application on 
your computer to generate static webpages, which are 
then uploaded to a web server



166 results (as of January 2017)



Jekyll 

Ruby-based static site generator created & maintained 
by GitHub that produces blindingly fast websites 

jekyllrb.com 

$0 & open source

























Posts have URLs like https://
www.chainsawonatireswing.com/2015/07/04/title-

page-of-3rd-edition-of-encyclopedia-

brittanica/ 

You can also create pages as well, with URLs like 
https://www.chainsawonatireswing.com/

subscribe/ 

Pages are created in folders for that page/section of the 
website









Powerful & flexible, but you need to understand how to 
use the command line 

Read the documentation carefully & look for articles 
online with tips



How to install Jekyll 

$ gem install jekyll

$ jekyll new my-awesome-site

$ cd my-awesome-site

$ jekyll serve

# => Now browse to http://localhost:4000





Kirby 

A file-based static site generator that lets you organize 
content in folders & write in text files in Markdown 

getkirby.com 

$17 / $89









Coding



Editors



BBEdit 

Excellent, powerful text editor dating back to 1992! 

www.barebones.com/products/bbedit/ 

$50





Sublime Text 

A powerful modern text editor with advanced features 

www.sublimetext.com 

$70





Atom 

Text & code editor, developed by GitHub, with support 
for plug-ins written in Node.js & embedded Git control 

atom.io 

$0 & open source





IDEs



“An integrated development environment (IDE) is a 
software application that provides comprehensive 
facilities to computer programmers for software 
development. An IDE normally consists of a source 
code editor, build automation tools and a debugger. 
Most modern IDEs have intelligent code completion.”



Brackets 

Flexible open source editor for HTML, CSS, & 
JavaScript with advanced features 

brackets.io 

$0

















Espresso 

Web development IDE (but we use it just for CSS) 

macrabbit.com/espresso/ 

$75





Visual Studio Code 

Microsoft’s excellent code editor for a wide variety of 
languages 

code.visualstudio.com 

$0 & open source























Pre-Processors



What’s a preprocessor? 

A program that processes input data & produces output 
that is then used as input to another program 

Input → Preprocessor → Output/Input → Program



Input Markdown-formatted file

Preprocessor Markdown converter

Output/Input HTML

Program Browser rendering engine



Common pre-processors

Markdown, Textile, & AsciiDoc HTML

TypeScript JavaScript

Sass, Less, & PostCSS CSS



Markdown → HTML



Markdown 

Lightweight markup language 

en.wikipedia.org/wiki/Markdown 

$0





Degrees of formatted text

Informal Plain text TXT

Informal markup Markdown

Formal markup HTML, XML

Formal Binary Word



Syntax



Paragraph 

Blank lines before & after





Headers 

Preface with #, ##, ###, ####, #####, or ###### 

&/or 

Underline with = for Header 1 
Underline with - for Header 2





Bulleted Lists 

Begin line with * or + or - 

Indent 4 spaces or 1 tab for sub-lists





Numbered Lists 

Begin line with 1. 

Actual order of numbers unimportant, so 1. 1. 1. is 
just as valid as 1. 2. 3. or even 3. 2. 1. 

Indent 4 spaces or 1 tab for sub-list





Code Blocks 

Indent with 4 spaces or 1 tab





Inline Code 

Surround code with `backticks`





Italics 

Surround with *star* or _underscore_ 

Bold 

Surround with **starstar** or _ _underscoreunder_ _





Links 

[Link text](URL "Optional Title")





Images 

![Alt text](URL "Optional Title")





Original Markdown does not support 

» Description (definition) lists 
» Tables 
» Attributes & values 
» Subscript & Superscript 
» Appendices 
» TeX or LaTeX 

(But just wait!)



You can always embed HTML in a Markdown 
document





Process



Create a file using your favorite text editor or a 
Markdown program 

Enter Markdown & text 

Convert to HTML or other desired output



File extension 

.md  

.markdown  

.mdown  

.mdwn  

.txt 

Actually, it doesn’t really matter



File extension 

.md  

.markdown  

.mdown  

.mdwn  

.txt 

Actually, it doesn’t really matter

What I use



Forks



MultiMarkdown 

Written by Fletcher Penney in C 

fletcherpenney.net/multimarkdown/





Outputs 
 
» HTML 
» LaTeX 
» OPML 
» OpenDocument XML (OpenOffice & LibreOffice)



Adds support for… 

» Definition lists 
» Tables 
» Link & image attributes 
» Footnotes 
» Metadata 
» Bibliographies 
» Appendices 
» Glossaries 
» TeX



Footnotes 

Text[^footnote-label]

Later in file: 

[^footnote-label]: Footnote text goes here









Image attributes 

![Image-Ref][]

Later in file: 

[Image-Ref]: URL "Title" width=100px 

height=100px class=value



PHP Markdown Extra 

Written by Michel Fortin in PHP 

michelf.ca/projects/php-markdown/extra/





Found in many PHP-based CMSs 

Outputs HTML



Adds support for… 

» Definition lists 
» Fenced Code Blocks 
» Tables 
» Footnotes 
» Abbreviations



Fenced Code Blocks 

Surround lines of code with either ``` or ~~~ 

Must match: if you use ```, end with ```





GitHub (Sundown) 

Written by GitHub developers in C 

Bindings with Ruby, Node.js, Python, PHP, Haskell, Go, 
.NET 

github.github.com/github-flavored-markdown/





Outputs HTML



Adds support for… 

» Fenced Code Blocks 
» Strikethrough 
» Superscripts & Subscripts 
» TeX & LaTeX math



Strikethrough 

--Text to strike--





Superscript 

mc^2^

Subscript 

H-2-O





Pandoc 

Convert between one markup format to another 

johnmacfarlane.net/pandoc/ 

$0





Outputs 

HTML, LaTeX, ConTeXt, Markdown, OPML, 
OpenDocument XML, ODT, Word docx, Textile, 
reStructuredText, RTF, PDF, DocBook, Texinfo, Groff 
man, MediaWiki, Emacs org-mode, EPUB, Slidy, S5



Adds support for… 

» Headers get automatic ID 
» Differing list numbers 
» Fenced Code Blocks 
» Tables 
» Footnotes 
» Strikethrough 
» Superscripts & subscripts 
» Metadata 
» Bibliographies 
» Templating 
» TeX



Differing list numbers 

1. List item

  A. Sub-list item

  B. Sub-list item

    1) Sub-sub-list item

    2) Sub-sub-list item

2. List item



Metadata 

% Title of document

% Author

% Date



Markdown → HTML 

pandoc -o foo.html foo.md



Markdown → Standalone HTML document 

pandoc -s -o foo.html foo.md



Markdown → Standalone HTML document, with smart 

punctuation 

pandoc -S -s -o foo.html foo.md



Markdown → Standalone HTML document, with smart 

punctuation & table of contents 

pandoc --toc -S -s -o foo.html foo.md



Markdown → EPUB 

pandoc -o foo.epub foo.md



Markdown → PDF 

pandoc -o foo.pdf foo.md



Software



Mou 

Full-featured & actively developed 

mouapp.com 

$0 while still in beta





Marked 

Markdown Preview for any text editor 

markedapp.com 

$3.99 in the Mac App Store









MarkdownPad 

Sort of like Mou for Windows 

markdownpad.com 

Free / $15 gets you no usage restrictions & many other 
features





Swiss Army Knives



CodeKit 

Compile pre-processors, preview, optimize, & build 
your projects 

incident57.com/codekit/ 

$32



















Prepros 

Cross-platform CodeKit, but not as full-featured 

prepros.io 

$29





Version Control



Version control tracks changes to source code 

Traditionally done via a centralized client-server model 
(e.g., CVS, Subversion) 

Distributed version control takes a peer-to-peer 
approach (e.g., BitKeeper, Mercurial, Git)



Git 

Designed & developed in 2006 (in 2 months!) by Linus 
Torvalds to manage the Linux kernel & now most 
widely-used in the world 

git-scm.com 

$0 & open source



git clone --recursive https://github.com/

getkirby/starterkit.git

Download, or clone, a project repository from a remote 
server so that I now have a complete copy



git add foobar.js bazquz.css

Add the files to the list of files you want to commit (add 
changed files to the history of your repository) 

git commit -m "Updated to support the new 

widget"

Add the changed files to your repo’s history along with a 
brief description of the changes



git status

See what changes exist between your copy & the remote 
repo 

git diff foobar.js

See changes between your local copy of a file & the 
remote repo



git pull

Copy any changes from the remote repo to your local 
copy 

git push

Copy any changes from your local copy to the remote 
repo (someone has to approve those before they’re 
actually added)



GitHub 

Most popular web-based Git repository hosting service 

www.github.com 

$0





Tower 

Git client 

www.git-tower.com 

$59





SourceTree 

Free & a lot more powerful than Tower, but more 
complicated too 

www.sourcetreeapp.com 

$0









Diffing



A diff tool calculates & displays the differences between 
two (or more) files 

Tremendously useful!



Kaleidoscope 

Diff & merge tool for text, images, & folders 

www.kaleidoscopeapp.com 

$70





DeltaWalker 

Diffs text files, folders, Office documents, & images 

www.deltopia.com/compare-merge-sync/ 

$30





Getting Help



Websites









Apps



Dash 

Offline API documentation browser & code snippet 
manager 

kapeli.com/dash 

$20





Zeal 

Copy of Dash without code snippets 

zealdocs.org 

$0





Browser Support















SEO



Scrutiny 

Check links, find problems, create a sitemap, check 
spelling & grammar, & more 

peacockmedia.software/mac/scrutiny/ 

$95

















Xenu Link Checker 

Checks websites for broken links 

home.snafu.de/tilman/xenulink.html 

$0 (Windows 95–10!)







W3C Link Checker 

Checks links in webpages or websites 

validator.w3.org/checklink 

$0











Testing



Validation & Linting



Validation: does the code conform to the specification?

















Linter: software that flags syntactic discrepancies in 
code, or code that doesn’t correspond to specified style 
guidelines 

Acts as simple debugger for common errors





Indentator  

Menu: Edit > Indent Document 

Keyboard: ⌃⌥I



Now press Ctrl+Alt+I…





When it comes to JavaScript, JSHint is preferable to 
JSLint





Browser Inspectors 
& Web Developer Tools









Let’s dive into Chrome’s Inspector 

To open: 

» View > Developer > Developer Tools 
» ⌥⌘I (Mac) 
» Ctrl+Shift+I (Windows) 
» Right-click & select Inspect 
» ☰/⋮ > More Tools > Developer Tools















































Toggle Device Toolbar (⌘⇧M/Ctrl+Shift+M)





















Local Testing



L inux Operating system

A pache Web server

M ySQL Database

P

erl

Programming languageHP

ython



W indows Operating system

A pache Web server

M ySQL Database

P

erl

Programming languageHP

ython



m acOS Operating system

A pache Web server

M ySQL Database

P

erl

Programming languageHP

ython



It would be very useful to run L/W/MAMP locally on 
your computer 

However, you do not want to install, set up, & configure 
everything by hand







Purpose c 

Web Server Apache Apache

Database MariaDB MariaDB

Database GUI phpMyAdmin phpMyAdmin

Language PHP PHP

HTTPS OpenSSL OpenSSL

Log Analysis Webalizer Webalizer

FTP Server FileZilla FTP Server ProFTPD

Sending Mail Mercury Mail Transport System sendmail



c 

XAMPP Control Panel, Tomcat, Strawberry Perl



 

SQLite, Perl, GD, Freetype2, libpng, gdbm, zlib, expat, 
Sablotron, libxml, Ming, pdf class, ncurses, mod_perl, 
FreeTDS, gettext, IMAP C-Client, OpenLDAP (client), 
mcrypt, mhash, cURL, libxslt, libapreq, FPDF, ICU4C 
Library, APR, APR-utils



Device Testing



BrowserStack 

Test websites on a huge range of browsers on platforms 

www.browserstack.com 

$12.50/month & up











Hosting



Operating System



I recommend Linux as the operating system for web & 
database servers 

Other versions of UNIX are good too 

If you have to use Windows, then use it



UNIX Background



UNIX invented in 1969 

Certain principles & goals from the beginning 
 
» Portable 
» Multi-tasking 
» Multi-user 
» Open standards 
» Plain-text ASCII files for data & configuration files 
» Stability



UNIX advantages 

» Powerful 
» Stable 
» Secure 

UNIX disadvantages 

» Built by techies for techies 
» Which UNIX ya talking about?



A vastly oversimplified UNIX family tree 

All (except those indicated) are still used today





BSD, 1994-1997





Linux 

Invented in 1991 by Linus 
Torvalds, a 21-year-old 
Finnish Computer Science 
student 

Linus wanted to run UNIX 
on his PC, but couldn’t afford 
an expensive license 

So he wrote his own UNIX, 
just for fun



Let’s be clear about what Linux is, exactly 

Linux is the kernel—that’s it 

When used to describe the operating system “Linux” is 
more of a slang term, covering the kernel & all the 
things on top of it





When choosing a Linux, you are really choosing a distro 
(“distribution”) 

A distro includes the Linux kernel &… 

» GNU tools & libraries 
» X Window System 
» Window Manager(s) 
» Desktop Environment(s) 
» Additional software 
» OS installer 
» Software package management system 

 
There are 100s of Linux distros!



Top Linux distros 

Mint 
Debian 
Ubuntu 
openSUSE 
Fedora 
Manjaro 
Mageia 
CentOS 
Arch 
Android-x86



Software



Ubuntu 

Widely-used, versatile Linux distro 

www.ubuntu.com/server 

$0





FreeBSD 

The most popular UNIX that’s not Linux or OS X 

www.freebsd.org 

$0 & open source





Web Server



What & How



What’s a web server? 

Both hardware & software



Software 

A computer program that serves webpages to clients



Hardware 

Computers that accept HTTP requests from clients 
(which don’t have to be Web browsers), & respond 

(Obviously the hardware is running the software) 



How do web servers work? 



“HTTP [the Hypertext Transfer Protocol] is the 
foundation of data communication for the World Wide 
Web. … HTTP is the protocol to exchange or transfer 
hypertext.” —Wikipedia



An HTTP session consists of a series of “hidden” 
network request-response transactions between the 
browser & web server







You type http://www.granneman.com/writing into 
your browser & press Enter 

Your web browser sends a request to the web server



GET /writing/ HTTP/1.1

Host: www.granneman.com

User-Agent: Mozilla/5.0 (Macintosh; Intel Mac OS 

X 10.11; rv:45.0) Gecko/20100101 Firefox/45.0

Accept: text/html,application/

xhtml+xml,application/xml;q=0.9,*/*;q=0.8

Accept-Language: en-US,en;q=0.5

Accept-Encoding: gzip, deflate

DNT: 1

Cookie: CONCRETE5=6h8714bfr5m4g33p4mawxple93

Connection: keep-alive

Cache-Control: max-age=0



The web server responds with a Yes, No, or Maybe





HTTP/1.1 200 OK

Date: Wed, 20 Apr 2016 17:02:26 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

Vary: User-Agent,Accept-Encoding

Expires: Thu, 19 Nov 1981 08:52:00 GMT

Cache-Control: no-store, no-cache, must-revalidate, 

post-check=0, pre-check=0

Pragma: no-cache

Content-Encoding: gzip

Content-Length: 4031

Keep-Alive: timeout=2, max=100

Connection: Keep-Alive

Content-Type: text/html; charset=UTF-8





The web server sends the webpage HTML to your web 
browser



<!DOCTYPE html>

<html lang="en" class="cID-95">

<head>

  <meta name="viewport" content="width=device-

width, initial-scale=1.0">

  <meta charset="UTF-8">

  <title>Writing :: Scott Granneman</title>

  <meta name="description" content="Scott 

Granneman's work as a professional writer." />

  <meta name="generator" content="concrete5 - 

5.6.3.1" />

…





Your web browser asks the web server for the 1st linked 
content (e.g., images, JavaScript, CSS) it sees in the 
webpage’s HTML 

Header info about the 1st linked content is sent by the 
web server to the browser 

The web server sends the 1st linked content to your web 
browser 

Repeat the above for each linked content item until 
complete



GET /themes/bootstrap/css/main.css HTTP/1.1

Host: www.granneman.com

User-Agent: Mozilla/5.0 (Macintosh; Intel Mac OS X 

10.11; rv:45.0) Gecko/20100101 Firefox/45.0

Accept: text/css,*/*;q=0.1

Accept-Language: en-US,en;q=0.5

Accept-Encoding: gzip, deflate

DNT: 1

Referer: http://www.granneman.com/writing/

Cookie: CONCRETE5=6h8714bfr5m4g33p4mawxple93

Connection: keep-alive

If-Modified-Since: Sat, 16 Apr 2016 21:11:23 GMT

If-None-Match: "3434-530a091d50037-gzip"

Cache-Control: max-age=0



HTTP/1.1 200 OK

Date: Wed, 20 Apr 2016 17:02:27 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

Vary: User-Agent,Accept-Encoding

Last-Modified: Sat, 16 Apr 2016 21:11:23 GMT

Etag: "3434-530a091d50037-gzip"

Accept-Ranges: bytes

Content-Encoding: gzip

Content-Length: 3253

Keep-Alive: timeout=2, max=100

Connection: Keep-Alive

Content-Type: text/css





GET /writings/ HTTP/1.1

Host: www.granneman.com

User-Agent: Mozilla/5.0 (Macintosh; Intel Mac OS 

X 10.11; rv:45.0) Gecko/20100101 Firefox/45.0

Accept: text/html,application/

xhtml+xml,application/xml;q=0.9,*/*;q=0.8

Accept-Language: en-US,en;q=0.5

Accept-Encoding: gzip, deflate

DNT: 1

Cookie: CONCRETE5=6h8714bfr5m4g33p4mawxple93

Connection: keep-alive

Cache-Control: max-age=0



HTTP/1.0 404 Not Found

Date: Wed, 20 Apr 2016 17:46:03 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

Vary: User-Agent

Expires: Thu, 19 Nov 1981 08:52:00 GMT

Cache-Control: no-store, no-cache, must-

revalidate, post-check=0, pre-check=0

Pragma: no-cache

Connection: close

Content-Type: text/html; charset=UTF-8





GET / HTTP/1.1

Host: secret.granneman.com

User-Agent: Mozilla/5.0 (Macintosh; Intel Mac OS 

X 10.11; rv:45.0) Gecko/20100101 Firefox/45.0

Accept: text/html,application/

xhtml+xml,application/xml;q=0.9,*/*;q=0.8

Accept-Language: en-US,en;q=0.5

Accept-Encoding: gzip, deflate, br

DNT: 1

Cookie: 

admin=h=698765b7653426q22110079g2b476ba9&id=scott

@granneman.com

Connection: keep-alive



HTTP/1.1 401 Unauthorized

Date: Wed, 20 Apr 2016 17:49:28 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

WWW-Authenticate: Basic realm="Scott Only"

Content-Length: 381

Keep-Alive: timeout=2, max=100

Connection: Keep-Alive

Content-Type: text/html; charset=iso-8859-1





HTTP/1.1 401 Unauthorized

Date: Wed, 20 Apr 2016 17:52:58 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

WWW-Authenticate: Basic realm="Scott Only"

Content-Length: 381

Keep-Alive: timeout=2, max=100

Connection: Keep-Alive

Content-Type: text/html; charset=iso-8859-1





HTTP/1.1 200 OK

Date: Wed, 20 Apr 2016 17:54:08 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

Vary: User-Agent,Accept-Encoding

Last-Modified: Sun, 27 Jul 2014 03:01:36 GMT

Etag: "242-4ff73294e061a-gzip"

Accept-Ranges: bytes

Content-Encoding: gzip

Strict-Transport-Security: max-age=15768000

Content-Length: 360

Keep-Alive: timeout=2, max=100

Connection: Keep-Alive

Content-Type: text/html



HTTP status codes 

1xx Informational 
2xx Success 
3xx Redirection 
4xx Client Error: cannot be fulfilled 
5xx Server Error: failed a valid request



Redirection? 

The requested resource has moved on the server, so 
browser needs to make a new request at a different URL 

301 Moved permanently; use new URL in future 
302 Moved temporarily; use original URL in future 

(incorrect usage by browsers) 
303 Moved temporarily; use original URL in future



GET /pubs/ HTTP/1.1

Host: www.granneman.com

User-Agent: Mozilla/5.0 (Macintosh; Intel Mac 

OS X 10.11; rv:45.0) Gecko/20100101 Firefox/

45.0

Accept: text/html,application/

xhtml+xml,application/xml;q=0.9,*/*;q=0.8

Accept-Language: en-US,en;q=0.5

Accept-Encoding: gzip, deflate

DNT: 1

Cookie: CONCRETE5=6h8714bfr5m4g33p4mawxple93

Connection: keep-alive



HTTP/1.1 301 Moved Permanently

Date: Wed, 20 Apr 2016 17:59:58 GMT

Server: Apache

X-Frame-Options: SAMEORIGIN

Vary: User-Agent

Expires: Thu, 19 Nov 1981 08:52:00 GMT

Cache-Control: no-store, no-cache, must-revalidate, 

post-check=0, pre-check=0

Pragma: no-cache

Location: http://www.granneman.com/writing/

Content-Length: 0

Keep-Alive: timeout=2, max=100

Connection: Keep-Alive

Content-Type: text/html; charset=UTF-8



Important Web Server Software



3 most important & widely-used web servers 

» Apache 
» IIS 
» Nginx



Apache 

World’s most widely-used web server 

httpd.apache.org 

$0 & open source





Powerful, highly configurable, & secure 

Extensive documentation & large number of developers 
& support options 

Many integrations with other software 

Extendable through modules 

Now 2 versions: 1.3.x & 2.x (use 2 if you can)



Wikipedia 
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NFL 

Facebook 
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State 
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Amazon 
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Scott Granneman 

Department of 
Defense



IIS: Internet Information Services 

Runs on Windows only 

iis.net 

Comes with Windows





Extendable through modules 

Was horrifically insecure, but much better now 

Nice GUI management & monitoring tools





SharePoint 

sharepoint.microsoft.com 

IIS + collaboration + search + document management 
+ process management modules + Office integration



SharePoint is meant for intranets, not the Internet 

“…installing SharePoint on premises typically requires 
multiple virtual machines, at least two separate 
physical servers, & is a somewhat significant 
installation & configuration effort.” —Wikipedia 

Now offered as part of Office 365 Software as a Service



Nginx (pronounced “Engine X”) 

Serves static content very quickly, with little resource 
usage, even under enormous loads 

nginx.org 

$0 & open source





Apache has built-in support for dynamic content via 
modules 

Nginx hands off requests for dynamic content to 
external processors & waits for the rendered results to 
be sent back 

Can be complicated to set up 

Advantage for Nginx is that static content is still served 
super-fast



Apache configuration is arcane, due to its age 

Nginx configuration is much more straightforward



Nginx can work together with Apache



Nginx handles static requests quickly, & passes off 
dynamic requests to Apache, which returns the results 
to Nginx so it can serve them back to users



Marketshare



August 2018



August 2018



August 2018



Database



What’s a Database?



“A database is an organized collection of data. It is the 
collection of schemas, tables, queries, reports, views 
and other objects. … 

A database management system (DBMS) is a 
computer software application that interacts with the 
user, other applications, and the database itself to 
capture and analyze data. A general-purpose DBMS is 
designed to allow the definition, creation, querying, 
update, and administration of databases.” —Wikipedia



Databases consist of at least 1 table 

Columns identify data 

Each row is a record



To track more data, just add columns: Operating 
systems, Car license plate, Locker number, Counselor



What happens to our table? 

It quickly becomes unmanageable & full of repetitive 
data 

The solution: relational databases



Types of Databases



“A relational database is a digital database whose 
organization is based on the relational model of data … 
Virtually all relational database systems use SQL… 

Each row in a table has its own unique key. Rows in a 
table can be linked to rows in other tables by adding a 
column for the unique key of the linked row (such 
columns are known as foreign keys) 

This model organizes data into one or more tables (or 
relations) of columns and rows, with a unique key 
identifying each row.” —Wikipedia









Many databases used today are NoSQL 

» Based on documents, not tables, structured with 
XML or JSON 

» Very fast 
» Designed to scale horizontally



NoSQL databases 

» MongoDB 
» Redis 
» CouchDB



Software



One way to classify relational databases 

» High-end 
» Mid-tier 
» Personal/departmental



High-end 

» Hundreds of tables 
» Millions of records 
» Constant input & output 

Examples 

» Oracle 
» IBM DB2 
» Microsoft SQL Server



Mid-Tier 

Not as robust as high end, but still very powerful



MySQL 

World’s most popular open source database 

www.mysql.com 

$0 or $2,000+







Oracle purchased MySQL in 2008 as part of Sun, & 
promptly angered the open source developers who had 
worked on it 

Forks started appearing soon after



Drizzle 
Forked from MySQL v. 6; last stable release in 2012 

MariaDB  
Led by the original developers of MySQL as a drop-in 
replacement for MySQL 

Percona Server 
Another drop-in replacement that includes features 
only available in MySQL’s Enterprise edition



PostgreSQL 

Great database, but not supported by as many open 
source projects 

www.postgresql.org 

$0 & open source





Personal/Departmental 

Meant for one person or a small department 

Can connect to small Intranet 

Never connect to the Internet! 

Examples 

» Microsoft Access 
» FileMaker Pro



Services



Cloud computer layers 

Cloud Clients (browser, terminal, mobile) 
↑↓  

SaaS: Software as a Service 
↑  

PaaS: Platform as a Service 
↑  

IaaS: Infrastructure as a Service



SaaS: Software as a Service 

Network-based access to software 

Centralized management 

Centralized updating 

Usually a monthly or annual flat fee per user



SaaS examples 

Google Apps (Gmail, Google Drive, & Google Calendar) 

Salesforce.com 

Microsoft Office 365



PaaS: Platform as a Service 

Network-based access to computing platforms (OS, 
environment, database, web server) for building & 
hosting cloud apps 

Easy to deploy applications without cost & complexity 
of buying & managing underlying hardware & software



PaaS is for developers who want to create web-based 
apps but don’t want to mess with setting up a server 
from scratch & administering it 

It’s like they want to rent a furnished apartment



PaaS examples 

AWS Elastic Beanstalk 

Google App Engine 

Microsoft Azure Cloud Services 

Heroku (Ruby on Rails) 

Force.com (Salesforce)



IaaS: Infrastructure as a Service 

Network-based access to a virtualized server, software, 
datacenter, storage, & network equipment 

Billed like a utility, based on what is used



IaaS is for developers who want to create web-based 
apps & don’t mind messing with setting up a server 
from scratch & administering it 

It’s like they want to rent an apartment & don’t mind 
furnishing it themselves



IaaS examples 

Amazon EC2, S3, & EBS 

Azure Services Platform 

Google Compute Engine 

Rackspace Cloud 

Oracle Infrastructure as a Service



Types of hosting services

Virtual Many sites on 1 server share same IP address

Shared Many sites on 1 server, maybe sharing IPs

Virtual Dedicated Virtualization: each site thinks it’s unique

Dedicated User controls server, but doesn’t own it

Co-located User owns server & has full control over it

Clustered Many servers hosting same content



AWS





Amazon Web Services (AWS) 

Launched July 2002 to take advantage of underutilized 
infrastructure, technologies, & operations that power 
Amazon’s $10 billion online store 

Now offers over 70 services!





Aimed at developers, not end users 

Billed on usage: no contracts & no minimums (keep an 
eagle on your usage!) 

99.95% reliability (some services offer 
99.999999999%!)



EC2 (Elastic Compute Cloud) 

Virtualized cloud-based servers 

aws.amazon.com/ec2/ 

$variable









EBS (Elastic Block Store) 

Resizable cloud-based persistent storage for EC2 

aws.amazon.com/ebs/ 

$variable





S3 (Simple Storage Service) 

Cloud-based storage service 

aws.amazon.com/s3/ 

$variable





Linode



Founded in 2003 

Data centers in Texas, California, Georgia, New Jersey, 
London, & Tokyo 

Supports two-factor authentication











Connecting



Control Panels



Hosting companies often provide control panels: web-
based software that enables you to connect & manage 
your account’s website, SFTP, & more 

Make sure you’re using HTTPS!



SSH



iTerm 2 

Powerful, flexible, open source terminal emulator 

www.iterm2.com 

$0





MobaXterm 

Easily the best Windows SSH client (& a lot more) 

mobaxterm.mobatek.net 

$0 or $69 for Professional Edition









SFTP



FTP: File Transfer Protocol 
Completely insecure: do not use! 

SFTP: Secure File Transfer Protocol 
Encrypted via SSH 

SCP: Secure Copy 
A simpler way to copy files, also based on SSH



Transmit 

File transfer via FTP, SFTP, S3, & WebDAV 

panic.com/transmit/ 

$34





Cyberduck 

File transfer via FTP, SFTP, WebDAV, S3, & Azure 

cyberduck.ch 

$0 & open source





WinSCP 

File transfer via SFTP, SCP, FTPS, & FTP 

winscp.net 

$0 & open source









Security



SSL/TLS



SSL (Secure Sockets Layer) & TLS (Transport Layer 
Security) provide HTTPS



Why Use SSL?



All web traffic sent via HTTP is in the clear, so anyone 
packet sniffing can see everything 

A problem for e-commerce & sensitive data! 

(Frankly, a problem with any data & content)



The solution: encrypt all traffic between your web 
browser & the web server 

HTTPS instead of HTTP



Google ranks HTTPS pages higher



How SSL Works



A certificate authenticates the identity of a website to 
the web browser



Before the certificate provider issues a certificate, it has 
to vet the requester to make sure she is the owner of the 
site



Requester selects from 3 different types of certificates, 
each based on increasingly difficult vetting & validation 
(& expense)



Domain validation 
Does the requester have admin rights over the domain 
name? 

Organization validation 
Same as Domain + is the organization an actual legal 
entity? 

Extended validation 
Same as Organization + do manual verification checks by 
a person prove that the organization is an actual legal 
entity?



















Commercial certs are “built in” to all web browsers, so 
the browsers recognize the companies issuing the certs 
(certificate authorities) & the certs themselves 

Everything is therefore transparent to the end user



Options > Advanced > Security > 
View Certificates

Internet Options > Content > 
Certificates

Settings > Show Advanced… > 
Manage Certificates…

Keychain Access app > Certificates





Process for enabling SSL for a website 

1. Get a certificate 
2. Configure the web server’s configuration file for the 

website to use SSL 
3. Test



Getting an SSL Certificate



Acquire 
Buy 
Generate 



Acquire



Hosting services usually offer certs as a value add





Registrars





Buy



Certificate providers





Generate



Certificates cost $ (sometimes a lot!) 

Your web server can also generate its own cert for free



Why not just use the free cert?



If the web server generates the cert itself, it is self-
signed 

The user’s web browser doesn’t have a built-in 
certificate identifying the certificate authority (because 
it’s your server saying that it can be trusted!) 

Therefor, the user sees a scary warning









Let’s Encrypt





Configuration



A website has to be configured on its web server to use 
SSL



Testing





Backup



rsync.net 

Remote backup on ZFS filesystem using rsync over SSH 

rsync.net 

$.08/GB/month & up





“Create an SSH key, write and run one or more rsync 
commands, and place into your crontab. Simple.”



CrashPlan 

Encrypted cloud backup 

www.crashplan.com 

$4/month











Monitoring



Munin 

Monitors computers to show you historical & current 
data 

munin-monitoring.org 

$0 & open source







Monit 

Monitors UNIX systems & conducts automatic 
maintenance & repair if problems are found 

mmonit.com/monit/ 

$0 & open source



















fail2ban 

Command line program that scans server logs & bans 
IP address that act maliciously 

www.fail2ban.org 

$0 & open source











Passwords



1Password 

Powerful & easy-to-use password (& much more!) safe 

agilebits.com/onepassword 

$50













Enpass 

Full-featured, cross-platform password (& more) safe 

www.enpass.io 

$0 desktop / $10 mobile

















Thank you! 

scott@granneman.com 
www.granneman.com 
ChainsawOnATireSwing.com 
@scottgranneman 

jans@websanity.com 
websanity.com
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Changelog 

2020-06-17 1.3: Removed Fargo 

2018-01-18 1.2: Changed theme to Granneman 1.5; 
fixed minor formatting issues; expanded bad domain 
names, with screenshots



Changelog 

2018-01-18 1.1: Changed theme to Granneman 1.3; 
fixed formatting; added Enpass; Added Windows 
modifier keys; add Draft to Collaboration; added slides 
for CodeKit, Monit, CrashPlan, & others; lots of little 
fixes & improvements; better wording in a few places; 
more on OmniOutliner; improved pre-processors; 
added the Finger 

2016-04-27 1.0: First version
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